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      MPLAB® XPRESS EVALUATION

BOARD USER’S GUIDE

Preface
INTRODUCTION

This chapter contains general information that will be useful to know when using the 
Microchip MPLAB® Xpress Evaluation Board User’s Guide. Topics discussed in this 
chapter include:

• Document Layout

• Conventions Used in this Guide

• Recommended Reading

• The Microchip WebSite

• Development Systems Customer Change Notification Service

• Customer Support

• Revision History

DOCUMENT LAYOUT

This document describes how to use the MPLAB® Xpress Evaluation Board User’s 
Guide as a development tool to emulate and debug firmware on a target board. The 
document is organized as follows:

• Chapter 1. “Introduction to the MPLAB® Xpress Evaluation Board” – This 
chapter contains general information regarding the Xpress Evaluation Board kit 
contents, layout and power sources.

• Chapter 2. “Getting Started” – This chapter offers information on how to 
program the Xpress Evaluation Board, as well as how to import an existing 
MPLAB X IDE project.

• Appendix A. “Schematic” – This appendix contains the Xpress Evaluation 
Board schematic.

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and 
documentation are constantly evolving to meet customer needs, so some actual dialogs 
and/or tool descriptions may differ from those in this document. Please refer to our website 
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each 
page, in front of the page number. The numbering convention for the DS number is 
“DSXXXXXXXXA”, where “XXXXXXXX” is the document number and “A” is the revision level 
of the document.

For the most up-to-date information on development tools, see the MPLAB® IDE online help.
Select the Help menu, and then Topics to open a list of available online help files.
 2016 Microchip Technology Inc.  DS50002479A-page 7
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CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS

Description Represents Examples

Arial font:

Italic characters Referenced books MPLAB® IDE User’s Guide

Emphasized text ...is the only compiler...

Initial caps A window the Output window

A dialog the Settings dialog

A menu selection select Enable Programmer

Quotes A field name in a window or 
dialog

“Save project before build”

Underlined, italic text with 
right angle bracket

A menu path File>Save

Bold characters A dialog button Click OK

A tab Click the Power tab

N‘Rnnnn A number in verilog format, 
where N is the total number of 
digits, R is the radix and n is a 
digit.

4‘b0010, 2‘hF1

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1>

Courier New font:

Plain Courier New Sample source code #define START

Filenames autoexec.bat

File paths c:\mcc18\h

Keywords _asm, _endasm, static

Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants 0xFF, ‘A’

Italic Courier New A variable argument file.o, where file can be 
any valid filename

Square brackets [ ] Optional arguments mcc18 [options] file 
[options]

Curly brackets and pipe 
character: { | }

Choice of mutually exclusive 
arguments; an OR selection

errorlevel {0|1}

Ellipses... Replaces repeated text var_name [, 
var_name...]

Represents code supplied by 
user

void main (void)
{ ...
}

DS50002479A-page 8   2016 Microchip Technology Inc.
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RECOMMENDED READING

This user’s guide describes how to use the Xpress Evaluation Board. For the latest 
information on using other tools, refer to the MPLAB® X IDE home 
page: www.microchip.com/mplabx/. This resource page contains updated 
documentation, downloads and links to other MPLAB X IDE compatible tools, plug-ins 
and much more.

THE MICROCHIP WEBSITE

Microchip provides online support via our website at www.microchip.com. This website 
is used as a means to make files and information easily available to customers. Acces-
sible by using your favorite Internet browser, the website contains the following infor-
mation:

• Product Support – Data sheets and errata, application notes and sample 
programs, design resources, user’s guides and hardware support documents, 
latest software releases and archived software

• MPLAB® Xpress Evaluation Board User’s Guide – Specific product support 
can be accessed via our website at www.microchip.com/mplab/mplab-xpress

• General Technical Support – Frequently Asked Questions (FAQs), technical 
support requests, online discussion groups, Microchip consultant program 
member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip 
press releases, listing of seminars and events, listings of Microchip sales offices, 
distributors and factory representatives

DEVELOPMENT SYSTEMS CUSTOMER CHANGE NOTIFICATION SERVICE

Microchip’s customer notification service helps keep customers current on Microchip 
products. Subscribers will receive e-mail notification whenever there are changes, 
updates, revisions or errata related to a specified product family or development tool of 
interest.

To register, access the Microchip website at www.microchip.com, click on Customer 
Change Notification and follow the registration instructions.

The Development Systems product group categories are:

• Compilers – The latest information on Microchip C compilers, assemblers, linkers 
and other language tools. These include all MPLAB C compilers; all MPLAB 
assemblers (including MPASM™ assembler); all MPLAB linkers (including 
MPLINK™ object linker); and all MPLAB librarians (including MPLIB™ object 
librarian).

• Emulators – The latest information on Microchip in-circuit emulators.This 
includes the MPLAB REAL ICE™ and MPLAB ICE 2000 in-circuit emulators.

• In-Circuit Debuggers – The latest information on the Microchip in-circuit 
debuggers. This includes MPLAB ICD 3 in-circuit debuggers and PICkit™ 3 
debug express.

• MPLAB X IDE – The latest information on Microchip MPLAB X IDE, the Windows® 
Integrated Development Environment for development systems tools. This list is 
focused on the MPLAB IDE, MPLAB IDE Project Manager, MPLAB Editor and 
MPLAB SIM simulator, as well as general editing and debugging features.

• Programmers – The latest information on Microchip programmers. These include 
production programmers, such as MPLAB REAL ICE in-circuit emulator, MPLAB 
ICD 3 in-circuit debugger and MPLAB PM3 device programmers. Also included 
are non-production development programmers, such as PICSTART® Plus and 
PICkit 2 and 3.
 2016 Microchip Technology Inc.  DS50002479A-page 9
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CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

• Distributor or Representative

• Local Sales Office

• Field Application Engineer (FAE)

• Technical Support

Customers should contact their distributor, representative or Field Application Engineer 
(FAE) for support. Local sales offices are also available to help customers. A listing of 
sales offices and locations is included in the back of this document.

Technical support is available through the website at: 

http://www.microchip.com/support.

REVISION HISTORY

Revision A (April 2016)

Initial release of this document.
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BOARD USER’S GUIDE

Chapter 1.  Introduction to the MPLAB® Xpress Evaluation Board
The MPLAB Xpress Evaluation Board is a development tool designed to work in 
conjunction with the cloud-based MPLAB Xpress Integrated Development Environ-
ment (IDE). The combination of the IDE and the Xpress Evaluation Board allows for 
quick experimentation and code development without having to download the IDE or 
compilers. The Xpress board contains a built-in programmer and includes an 8-bit 
PIC16F18855 microcontroller, allowing for easy programming without additional pro-
gramming tools. The Xpress board also contains a set of four indication LEDs, a poten-
tiometer, a push button switch and a mikroBUS™ socket to accommodate a variety of 
plug-in MikroElektronika click boards that can be used in application development. The 
Xpress board contains two sections: the programmer section and the application sec-
tion. The programmer section contains the circuitry necessary for programming, while 
the application section contains the circuitry that is used by the application.

1.1 MPLAB Xpress EVALUATION BOARD KIT CONTENTS

The Xpress Evaluation Board kit contains the following:

• Xpress Evaluation Board

• Quick Start Guide

FIGURE 1-1: MPLAB® Xpress EVALUATION BOARD KIT 
 2016 Microchip Technology Inc.  DS50002479A-page 11



MPLAB® Xpress Evaluation Board User’s Guide
1.2 MPLAB Xpress EVALUATION BOARD LAYOUT

Figure 1-2 identifies the major features of the MPLAB Xpress Evaluation Board.

FIGURE 1-2: MPLAB® Xpress EVALUATION BOARD LAYOUT 
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1. PIC® MCU Input/Output Connections

2. PIC16F18855 Microcontroller

3. mikroBUS™ Click Board Socket

4. LEDs

5. Potentiometer

6. Push Button

7. Master Clear Reset Button

8. Battery Connection

9. Micro USB Connector
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1.3 POWER SOURCES

The MPLAB Xpress Evaluation Board can be powered in one of two ways, depending 
on its usage. It should be noted that only one power source should be connected at a 
time.

1.3.1 USB Connector (J2)

The USB connector (J2) will power the entire Xpress Evaluation Board. With USB 
power connected to J2, power LED D1 will always be on (green) to indicate that +3.3V 
is available on the board.

1.3.2 2.7V-16V External Power Supply

The external power supply (Figure 1-2) will also power the entire Xpress Evaluation 
Board. The external power supply is connected to a Low Dropout (LDO) voltage 
regulator, configured to deliver 3.3V to the Xpress board. The external power supply 
range is from 2.7V to 16V, allowing use with two to six primary cell, 9V alkaline 
batteries, or one or two-cell Li-Ion batteries. LED D1 will illuminate green when the 
external power supply is active and supplying sufficient voltage.
 2016 Microchip Technology Inc.  DS50002479A-page 13
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Chapter 2.  Getting Started 
The Xpress Evaluation Board was designed to work with the MPLAB Xpress IDE, but can 
also be used with MPLAB X IDE. MPLAB Xpress IDE does not require any downloads 
and can be accessed by visiting mplabxpress.microchip.com.

The Xpress Evaluation Board allows for rapid development of custom applications 
without the need to download the IDE or compilers to a computer and allows the 
storage of a project in the cloud. This allows a user the ability to access their project 
from virtually anywhere (requires Internet connection) and from any computer. 
Microchip also provides code examples to help get you started.

2.1 PROGRAMMING THE MPLAB Xpress EVALUATION BOARD

Programming the Xpress board is accomplished by connecting a micro USB cable to 
the on-board USB connector (J2), creating the .hex file, and dragging and dropping 
the .hex file into the Xpress board. 

To begin, connect a micro USB cable to the on-board USB connector (J12). Next, open 
the MPLAB Xpress IDE.

FIGURE 2-1: SELECTING THE Xpress EVALUATION BOARD IN THE MPLAB® X IDE 
 2016 Microchip Technology Inc.  DS50002479A-page 15
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FIGURE 2-2: SELECTING THE XPRESS EVALUATION BOARD IN THE 
MPLAB XPRESS IDE (CONT)
DS50002479A-page 16   2016 Microchip Technology Inc.
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Once MPLAB Xpress is configured and connected to the Xpress Evaluation Board, a 
new project can be started, or either an existing MPLAB Xpress project or MPLAB X 
IDE project can be loaded. The procedure to create a new project or open an existing 
MPLAB Xpress project is the same as within MPLAB X IDE. Navigate to the File tab, 
select Project Properties > Configuration > Hardware Tool > Hardware Tools and select 
‘Simulator/Xpress Board’ (see Figure 2-1). This ensures that the Xpress board is 
chosen as the development tool. Once selected, the ‘Simulator/Xpress Board’ selec-
tion will appear under the ‘Debug Tool’ section in the Dashboard window (see 
Figure 2-2). Once the project is open and ready to program into the target device, 
simply click on the Make and Program Device button (see Figure 2-3). MPLAB Xpress 
will build and compile the project, and once completed, will open or save the .hex file 
that was created. Under the Save button, you can either hit Save and the .hex file will 
be stored in your downloads folder, or you can hit Save as and choose the location for 
the .hex file. It is important to remember where the file is stored since the .hex file is 
what will be 
programmed into the target PIC® device.

FIGURE 2-3: MAKE AND PROGRAM DEVICE 
 2016 Microchip Technology Inc.  DS50002479A-page 17
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The Xpress Evaluation Board will show as a mass storage device on the computer (see 
Figure 2-4). To program the device, simply drag and drop the .hex file image into the 
Xpress drive. 

FIGURE 2-4: MPLAB® Xpress BOARD AS MASS STORAGE
DS50002479A-page 18   2016 Microchip Technology Inc.
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2.2 USING AN EXISTING MPLAB X IDE PROJECT

To load an existing MPLAB X IDE project into MPLAB Xpress, the MPLAB X IDE project 
must be packaged so that it can be imported by MPLAB Xpress. In MPLAB X IDE, right 
click on the project that is to be imported into MPLAB Xpress and select Package. 
MPLAB X IDE will create a ZIP file that will be imported by MPLAB Xpress. Open 
MPLAB Xpress and under the File tab, select Import Project (see Figure 2-5). 

FIGURE 2-5: IMPORT EXISTING MPLAB® X IDE PROJECT 
 2016 Microchip Technology Inc.  DS50002479A-page 19
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The Import Project window will appear (see Figure 2-6). The window also explains how 
to prepare your MPLAB X IDE project to import. Click Next.

FIGURE 2-6: IMPORT PROJECT WINDOW 
DS50002479A-page 20   2016 Microchip Technology Inc.



Getting Started
The Import Project window will now ask for a project name and allow you to 
browse for your MPLAB X IDE project (see Figure 2-7). Add a name to your 
project and then navigate to the folder in which your ZIP file was stored. Select 
the ZIP file and click Finish. MPLAX Xpress will then open your ZIP file and 
load the necessary files. 

FIGURE 2-7: NAMING AND SELECTING MPLAB® X IDE PROJECT TO IMPORT
 2016 Microchip Technology Inc.  DS50002479A-page 21
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Appendix A. Schematic

A.1 MPLAB Xpress EVALUATION BOARD SCHEMATIC

FIGURE A-1: MPLAB® Xpress EVALUATION BOARD SCHEMATIC (APPLICATION SECTION) 
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Schematic
FIGURE A-2: MPLAB® XPRESS EVALUATION BOARD SCHEMATIC (PROGRAMMER 
SECTION)
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